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Abstract

Many interconnected degradation machineries including autophagosomes, lysosomes, and
endosomes work in tandem to conduct autophagy, an intracellular degradation system that is crucial
for cellular homeostasis. Altered autophagy contributes to the pathophysiology of various diseases,
including cancers and metabolic diseases. Although many studies have investigated autophagy to
elucidate disease pathogenesis, identification of specific components of the autophagy machinery has
been challenging. The goal of this paper is to describe an approach to reproducibly identify and
distinguish subcellular structures involved in macro autophagy. We provide methods that help avoid
common pitfalls, including a detailed explanation for distinguishing lysosomes and lipid droplets and
discuss differences between autophagosomes and inclusion bodies. These methods are based on
using transmission electron microscopy (TEM), capable of generating nanometer-scale micrographs
of cellular degradation components in a fixed sample. We also utilize serial block face-scanning
electron microscopy (SBF-SEM) to offer a protocol for visualizing 3D morphology of degradation
machinery. In addition to TEM and 3D reconstruction, we discuss other imaging techniques, such as
immunofluorescence and immunogold labeling that can be utilized to reliably and accurately classify
cellular organelles. Our results show how these methods may be used to accurately quantify the
cellular degradation machinery under various conditions, such as treatment with the endoplasmic
reticulum stressor thapsigargin or ablation of the dynamin-related protein 1.

1 Introduction

Macroautophagy, the mechanism by which intracellular components or damaged organelles are
removed and degraded to maintain cellular homeostasis [1], has much relevance in the fields of
disease research and drug development. Although poorly understood, autophagy regulation is broadly
implicated in disease pathogenesis, with both overactive and underactive autophagy having negative
consequences, including malignant transformation and cellular proliferation in cancer or
accumulation of ineffective cells in neurodegenerative diseases [2,3]. Autophagic processes differ
depending on their activation pathways, being either non-selective or selective for specific cellular
organelles or proteins [1,2]. Growing interest in neurodegenerative and other diseases with autophagy
implications has highlighted its consequential roles in key biological processes [1,4].

The complex, regulated macro autophagic process involves structures that also contribute to the
cellular recycling machinery specifically, autophagosomes and lysosomes (Figure 1A). The main
stages of autophagy include initiation, elongation, autophagosome formation, autophagosome
recruitment and maturation, fusion, and degradation [1-3]. In the initiation stage, often triggered by
amino acid starvation, sack-like autophagosome precursors, called phagophores, assemble adjacently
to the endoplasmic reticulum, typically at mitochondria-associated endoplasmic reticulum (ER)
membrane (MAM) (Figure 1B) [5]. The phagophore resides proximal to the ER as an empty,
unclosed membrane. As materials are delivered to the phagophore, the membrane closes to seal the
organelle, transforming the phagophore into an autophagosome, which carries cytoplasmic
components, cargo proteins or organelles designated for degradation. In many cases, the
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71  autophagosome then ultimately fuses with a lysosome, containing hydrolases and permeases, to form
72 an autolysosome and initiate degradation (Figure 1B). In some cases, the autophagosome may mature
73  through an intermediate prior to lysosome fusion known as an amphisome [6]. Importantly, this

74  endosome fusion event may occur to allow for retrograde transport motility, so amphisomes can

75  move to lysosome dense areas [6,7]. In either case, after autolysosome formation, the resulting

76  macromolecules are released through permeases and the ultimate fate of autolysosomes following

77  this process is still unclear [8]. Some autolysosome components can be used to reform lysosomes or
78  become part of new phagophore membranes. Macromolecules released into the cytosol are recycled
79  for use in other biological functions [1-3,9].

80  Transmission electron microscopy (TEM) has advanced autophagy research by enabling the study of
81  subcellular components at high resolution [4]. By transmitting electrons through ultrathin sections of
82  fixed and embedded samples, TEM generates nanometer-scale micrographs that allow study of

83  autophagic processes [10—12]. For example, past studies have utilized TEM to show autophagosome
84  formation at MAMs and have delineated the maturation process described above [10,12]. Our

85  method uses the free, open-source Imagel software platform to analyze TEM micrographs of

86  autophagic components [13], enabling image quantitation and statistical analysis [11]. Here we

87  applied this established TEM method recently described by Lam et al. [11] to analyze mitochondria
88 and ER.

89  While TEM is powerful for identification, it only allows for two-dimensional (2D) visualization of
90 organelles. This may not always be an accurate representation since organelles are three-dimensional
91 (3D) objects. Therefore, we also included reconstrucions from serial block face-scanning electron

92  microscopy (SBF-SEM) [14], which functions by slicing a sample in the z-axis to obtain orthoslices
93  [15]. These orthoslices can then be hand-segmented, one-by-one, to allow for the 3D rendereings of
94  an organelle to be evaluated [16]. While this allows for more accurate representation, there is a much
95  larger time and cost associated with it than TEM quantification. Here we also utilized an established
96  SBF-SEM method recently described by Garza-Lopez et al. [16], to perform 3D reconstruction of
97  recycling machinery organelle alongside TEM quantifications.

98  The success of our modified protocol depends on proper identification of cellular degradation

99  components. In Figure 1, we showcase how typical organelles should appear conventionally:
100  lysosomes (Figure 1C, red arrows), autolysosomes (Figure 1C-D, blue arrows), golgi (Figure 1C-D,
101  dark blue arrow), autophagosome (Figure 1D, green arrow), early endosome (Figure 1D, black
102 arrow), late endosome (Figure 1D, black outlined white arrow) and lipid droplets (Figure 1E, orange
103 arrow). However, identification is complicated by diverse morphologies with recycling machinery
104  sometimes not presenting typical presentation. For example, lysosomes are usually depicted as
105  spherical, typically ranging from 0.2 to 0.5 micrometers in diameter, although they can also
106  commonly present from 0.05 to 1 micrometers (Figure 2A—D; Table 1) [17-19]. Lysosomes are
107  typically transported by microtubules to the region around the microtubule-organizing center [20];
108  however, intracellular conditions, such as raised pH, cause lysosomes to migrate toward the cell
109  membrane [21]. Lysosomes are classified as primary, secondary, or tertiary, depending on their
110  digestive activities and their formation process. Lysosome identification is further complicated by
111  their tendency to feature multiple membranes [22]. In quantifying lysosomes, researchers must avoid
112 misidentifying them as multilamellar vesicles, also identified as late endosomes or multilamellar
113 bodies (MLBs; Figure 2E—F; Table 1), which contain lipids within a central compartment surrounded
114 by many membrane bilayers [23]. Lysosomes should not be mistaken for multi-inclusion bodies and
115  multivesicular bodies (MVBs), also known as pre-vacuolar compartments, that are an intermediary
116  structure between vacuoles and the trans-Golgi network (Table 1) [24]. Although these structures are
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117  related to autophagy, they differ from lysosomes and autophagosomes and should be excluded from
118  both their quantifications [25]. Lysosomal membranes have highly organized inner folds and

119  lysosomal enzymes have a distinct, darker, and more consistent appearance than the lipids found in
120  MLBs (Figure 2A-F; Table 1). MLB lipids can also appear as dots that speckle the MLB interior,
121 which can be used to differentiate MLBs from lysosomes, although these dots can also be mistaken
122 for cargo in secondary lysosomes (Figure 1A-C; Table 1). Despite these considerations, accurate and
123 reproducible lysosome identification based solely on TEM imaging may be inconsistent,

124 necessitating use of imaging techniques, such as fluorescent staining. Not only do we need to

125  positively identify lysosomes, but autophagosomes must be identified, characterized, and

126  distinguished from lysosomes and other structures.

127  Autophagosome appearance can also vary depending on the cargo, further complicating their

128  identification (Figure 2G-H; Table 1). Autophagosomes typically have clear double-limiting

129  membranes that appear darker than the rest of the TEM image, separated by a small electron lucent
130 space. However, autophagosomes may also appear with a single membrane or with several separate
131  membranes due to fixation techniques (Figure 2G-H; Table 1) [26]. These diverse membrane

132 presentations can cause misidentification of malformed mitochondria or ring-shaped ER as

133 autophagosomes. Because MVBs and MLBs only display a single membrane (Figure 2E-F; Table 1),
134 presence of a second membrane, in addition to inner recycled ribosomes, more circular shapes

135  representing cargo, or more internal lipids, all characterize autophagosomes (Figure 2G-H). [23,26].
136  However, improper fixation techniques may cause one of autophagosome limiting membranes to be
137  invisible [26]. MVBs are also generally smaller than autophagosomes and lysosomes, whereas ML.Bs
138 are larger, sometimes up to ten times the size of typical lysosomes [17,23]. During identification,
139  certain autophagosome types can be included or excluded. For example, if structures appear empty or
140  lacking material, they are likely not involved in degradation and may be excluded. For example, in
141  some disease states, autophagosomes may dysfunction in cargo recruitment and are known as

142 “empty” autophagosomes [27]. Therefore, a key trait of autophagosomes is the presence of cargo.
143 However, it is important to avoid classifying empty autophagosomes as lipid droplets (LDs; Figure
144  2I-K; Table 1). Similarly, if the body of a phagophore that has not yet closed (Figure 1B) to form an
145  autophagosome, it should not be mistaken as an autophagosome [4,26]. Autophagosomes that are in
146  the process of fusing with a lysosome, also known as lipofuscin granules (Figure 2C, 2E-D), but are
147  not yet considered autolysosomes, can be classified as autophagosome-lysosome fusions, and be

148  considered autolysosomes if their inclusion is consistent [1,2,28]. Since they, physiologically, are
149  similar to autolysosomes, our criteria includes them in autolysosome quantifications [29]. These

150 intermediate structures are identified by their much larger appearance, and contents of the lysosome
151  and the autophagosome often appear to be interacting (Figure 2C, 2E-D).

152 Autophagosomes that contain limited cargo volumes (Table 1) can mimic large, irregularly-shaped
153 lysosomes (Figure 2A; Table 1) [1,17]. Although autophagosomes can mainly be identified by two
154  limiting membranes, because lipids are not reliably preserved during sample preparation, limiting
155 membranes may vary in appearance, furthering potential for confusion [26]. Another key to

156  identifying autophagosomes formed from non-selective phagophores is recognizing nearby

157  cytoplasmic content inside of them; often autophagosomes can be identified by presenting cargo

158  originating from cytoplasmic content nearby the organelle [30,31]. Furthermore, autolysosomes can
159  differ in their presentation (Figure 2B-C, 2J-0O), especially lipofuscin granule autolysosomes (Figure
160  2C, E-D; Table 1) which may be mistaken for LDs (Figure 21-J; Table 1) or lysosomes (Figure 2A—
161  D; Table 1). Careful consideration of these features is essential to properly identify these organelles.
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162  Ultrastructural characteristics of organelles can be used to distinguish them from autophagic

163  components. For example, the presence of regularly-spaced ribosomes, which typically appear as
164  small black dots, or a thinner width wrapped around organelles such as mitochondria, strongly

165 indicate that the structure is ER. Similarly, evidence of mitochondrial cristae or inner membrane

166  folds can be used to identify mitochondrial structures. However, exact identification of specific

167  organelles can be complicated. For example, partially degraded ribosomes can aggregate in

168  autophagosomes, forming electron dense clumps as they degrade [26]. However, the presence of
169  ribosomes alone does not confirm an object is an autophagosome, as it is possible to mistake circular
170  cisterns of rough ER for autophagosomes [26]. Autophagosomes may be distinguished by their more
171  circular presentation and higher-degree of clumped ribosomes [12,26].

172 Although basic processes of autophagosome formation are understood, specific pathways and

173 degradation machinery require further study, such as lipid mobilization from LDs to provide energy.
174  Like all organelles, LDs are targeted by autophagy for recycling and interestingly, macromolecules
175  released by autophagy can be stored in new LDs, even under starvation conditions [32]. Thus, a

176  consequence of autophagy is increased LDs within a cell. These lipid droplets can protect against ER
177  stress and may protect against mitochondrial autophagy, known as mitophagy, by forming close

178  mitochondria-to-lipid contacts [33]. Autophagy impacts nearly every cellular organelle due to its role
179  in organelle degradation. For example, ER stress can initiate autophagy to recycle damaged ER

180  membranes, contributing to healthy ER [34]. Similarly, impaired mitochondrial fission or other |

181  dysfunctions due, for example, to impaired function of critical regulatory proteins, such as mitofusin
182 1 (MFNI), can trigger mitophagy to clear ineffective mitochondria [35,36]. Because all organelles
183  interact with the cellular degradation machinery, understanding the dynamics between primary

184  recycling organelles—Ilysosomes, autophagosomes, and autolysosomes—and other organelles is

185  critical to fully appreciate the contributions and drivers of autophagy. Careful and accurate

186 identification of components of the autophagy machinery are needed to advance our understanding of
187  therapeutic effectiveness, whose mechanisms of action may involve autophagy. This effort may

188  elucidate additional pathways that induce autophagy and clarify how autophagy contributes to

189  disease prevention and progression [37]. Accurate characterization and quantitation of autophagy
190  components requires proper identification of these degradation organelles and other subcellular

191  structures involved in autophagic processes.

192 Although many studies have identified components of autophagosome and lysosome machinery,

193 developing next-generation methods to rigorously identify and quantify these organelles is essential
194  to establish standardized protocols, allowing data comparison [10,26,38—40]. Many of these

195  structures are similar, but can differ from cell to cell and are easily misidentified. A basic

196  understanding of the potential and common appearances of lysosomes and autophagosomes is critical
197  for TEM analysis. Here, we describe characteristics that should be assessed to properly identify

198  autophagic organelles and provide recommendations for effective classification (Supplementary

199  Figure 1).

200  Our ultimate goal was to identify and quantify difficult-to-measure autophagic machinery in clear
201  terms and present a novel approach to measure all cellular degradation machinery using free, open-
202  source software. These techniques can be used to reproducibly quantify and characterize changes in
203  the organelles associated with autophagy. Furthermore, for researchers who wish to perform more
204  complex calculations and resource-intensive imaging, we also offer a protocol for 3D reconstruction
205  of recycling machinery.

206 2 Methods and Materials
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207  2.1. Mouse Care & Maintenance

208  Mouse husbandry was performed based on prior protocols [41] according to with protocols approved
209 by the University of lowa Animal Care and Use Committee (IACUC). Male C57BI1/6] mice were
210  housed at 22 °C with a 12-h light, 12-h dark cycle, and free access to water and standard chow. Mice
211  with a tamoxifen-inducible knockout of DRP1 in skeletal muscle were generated by crossing mice
212 carrying a homozygous floxed allele of DRP1 with mice carrying a tamoxifen-inducible Cre

213 recombinase under control of the myogenin promoter (Jackson Lab) in skeletal muscle as previously
214  described [42,43]. Myotubes were isolated from these mice, using protocols described below.

215  2.2. Fly Strains and Genetics:

216 A mitochondrial assembly regulatory factor (Marf) knockdown fly was generated according to

217  previous protocols [44]. Genetic crosses were performed on yeast corn medium at 22 °C. W1118
218  flies were used as genetic background controls. Mef2- Gal4 (III) was used to drive muscle-specific
219  Marf RNAi (BS# 55189) to achieve gene knockdown. Mef2-Gal4 (BS# 27390) stocks were obtained
220  from the Vienna Drosophila Stock Center and Bloomington Drosophila Stock Center. All

221  chromosomes and gene symbols are as mentioned in Flybase (http://flybase.org).

222 2.3.Isolation of Satellite Cells & Differentiation

223 When adopting this protocol, an individual who was blinded to the mouse genotype or treatment
224 conducted the experiment, including isolation, differentiation, and fixation of murine and human
225  cells. This individual did not perform later analyses to mitigate bias. Satellite cell isolation and

226  differentiation for thapsigargin treatment and DRP-1 ablation were performed as described

227  previously, with minor modifications [11,41,45]. When C57B1/J1 mice reached 8—10 weeks of age,
228  mice were anesthetized using isoflurane. Skeletal muscles of the gastrocnemius and quadriceps were
229  excised and washed twice with 1x phosphate-buffered saline (PBS) supplemented with 1%

230  penicillin-streptomycin and 0.3% fungizone (300 pL/100 mL). Dulbecco’s modified Eagle’s medium
231 (DMEM)-F12 media with 0.2% collagenase II (2 mg/mL), 1% penicillin-streptomycin, and 0.3%
232 fungizone (300 uL/100 mL) was added to the muscles and shaken for 90 min at 37 °C. This media
233 was removed, muscle was washed with PBS x4 times, and media replaced with DMEM-F12 media
234 containing 0.05% collagenase II (0.5 mg/mL), 1% penicillin-streptomycin, and 0.3% fungizone (300
235  upL/100 mL), before shaking for 30 min at 37 °C. Tissue was then ground until all cells were

236  dislodged from the tissue matrix and were passed through a fine, 70-pm cell strainer. Isolated cells
237  were centrifuged, resuspended, and plated on BD Matrigel-coated dishes. Adherent cells were

238  differentiated into myotubes by adding DMEM-F12, 20% fetal bovine serum (FBS), 0.004% (40
239  ng/mL) basic fibroblast growth factor (R&D Systems, 233-FB/CF), 1x non-essential amino acids,
240  0.14 mM B-mercaptoethanol, 1% penicillin/streptomycin, and 0.3% fungizone (300 uL/100mL).

241  Myotubes were maintained in medium containing 0.001% (10 ng/mL) growth factor until reaching
242 85% confluency, then were differentiated in DMEM-F12, 2% FBS, and 1% insulin—transferrin—

243  selenium.

244 2.4, Human Myotubes

245  GIBCO® Human Skeletal Myoblasts from ThermoFisher Scientific (A1255) were thawed and plated
246  in HG DMEM containing 1% penicillin/streptomycin, 1% fungizone, and 2% horse serum. Cells
247  were differentiated after 48 h, and myotubes were extracted.


https://doi.org/10.1101/2021.09.26.461841
http://creativecommons.org/licenses/by-nc-nd/4.0/

bioRxiv preprint doi: https://doi.org/10.1101/2021.09.26.461841; this version posted August 8, 2022. The copyright holder for this preprint
(which was not certified by peer review) is the author/funder, who has granted bioRxiv a license to display the preprint in perpetuity. It is made

available under aCC-EyNEeYR 461 ¢"PEIVISHASYEID & 3D of Cell. Degradation

248  Fibroblasts grown in vitro to the third passage were plated in 6-well tissue culture plates (5 x 103
249  cells per well) in DMEM (Invitrogen) supplemented with 10% heat-inactivated fetal bovine serum,
250 100 U/ml penicillin, 100 png/ml streptomycin, 0.25 pg/ml fungizone, 1 mm sodium pyruvate, and 10
251  mm HEPES at 37 °C in a humidified incubator with 10% COx. Cells were infected with Ad-Cre and
252  Ad-GFP was a control.

253 2.5 Immunogold Labeling

254  Immunogold labeling was performed as previously described [46]. Ultrathin cryosections were

255  prepared, and single- or double-immunogold labeling was performed using antibodies and protein A
256  coupled to gold. After labeling, sections were imaged via TEM. Specifically, primary skeletal

257  myotubes were fixed for 1 h in 4% paraformaldehyde (PFA) and 0.1% glutaraldehyde in 0.1 M

258  phosphate buffer. From there, vibratoming of 40-50 um section into 0.1M phosphate buffer was

259  performed. Each section was washed 3 times for 10 minutes each with the same 0.1 M phosphate
260  buffer. For the first blocking step, 0.1% NaBH4 in 0.1 M phosphate buffer was applied for 15

261  minutes. After blocking, phosphate buffer was used for washing 4 times for 10 minutes each time. To
262  permeabilize, 0.05% Triton X-100 in 0.1M phosphate buffer was applied and incubated for 15 mins
263  at 30 °C. After this, phosphate buffer was used for washing 3 times for 10 minutes each time. For the
264  second blocking, Aurion Blocking Solution was added and the solution was incubated at room

265  temperature for one hour. Incubation buffer was used to wash after blocking, again in triplicates of 10
266  minutes.

267  From there, 1-5 pg/ml of the primary antibody in incubation buffer was applied and incubation at 4
268  °C occurred overnight. For mitofusin-1, Anti-Mitofusin 1 antibody was used (Abcam; ab126575); for
269  CAV-1, caveolin-1 antibody was used (Cell Signaling Technology; 3238); and for LC3, LC3B (D11)
270  XP® Rabbit mAb was used (Cell Signaling Technology; 3868). After overnight, the incubation

271  buffer was used to rinse 6 times over, incubating for 10 minutes each time. From there, secondary
272  antibody incubation occurred with 1:100 ultrasmall gold conjugated secondary antibody in

273 incubation buffer overnight at 4 °C. After overnight, again the incubation buffer was used to rinse 6
274  times over, incubating for 10 minutes each time. Furthermore, 3 washes, each 10 minutes, of PBS
275  were also used. From there, post-fixation occurred through incubation in 2% Glutaraldehyde in 0.1M
276  phosphate buffer for 2 hours. After time elapsed, phosphate buffer was utilized for washing across 4
277  times, 10 minutes each time. It was quickly rinsed with distilled H2O for 15 seconds, three times. For
278  silver enhancement, AURION SE-EM silver enhancement solution was applied, and sample

279  incubated for 45 minutes at room temperature. From there, it was quickly rinsed with distilled H,O
280  for 15 seconds, three times. Phosphate buffer was also utilized for washing across 4 times, 10

281  minutes each time. Once washed, to perform osmification, 0.5% OsO4 in 0.1M phosphate buffer was
282  added for 15 mins. After this, the sample was finally washed in the same phosphate buffer for 10

283  minutes twice.

284  From there, dehydration and embedding in resin was performed. To do so, first the sample was again
285  placed in 4% PFA and 0.1% Glutaraldehyde for 1 h. From there, they were washed with phosphate
286  buffer three times for 20 minutes. Following this, a graded ethanol wash was performed at 15

287  minutes each progressing from 25% to 50% to 75% ethanol. 95% ethanol was finally used for wash
288  for 30 minutes. From there, the mixture was washed and replaced with an 1:1 mixture of 95% ethanol
289  and LR white resin for 1 hr. Finally, a pure 100% LR white resin solution was added. After an hour,
290 it was replaced with a new 100% LR white resin which again incubated at room temperature for 1 hr.
291  This sample was cured under UV overnight with a vacuum to remove any excess liquid. 90 nm

292  ultrathin sections were obtained and imaging occurred as described for TEM samples below.
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293
294 2.6 Lysotracker

295  The protocol was performed as previously described [47]. LysoTracker™ Red DND-99

296  (ThermoFisher Scientific, L7528) was diluted to a final concentration of I mM with dimethyl

297  sulfoxide (DMSO) to create a stock solution, which was then mixed with warm growth media at a
298  1:2000 dilution. Growth media was aspirated from cells and replaced with the working

299  LysoTracker™ Red DND-99 solution. Cells were imaged live using an SP-8 confocal inverted

300  microscope with a visible light laser at a 577 nm excitation wavelength and a 590 nm + 10 nm

301  emission wavelength, which allowed a yellowish pseudo coloration to be observed. To stain fixed
302 cells, cells were grown in culture media on a #1.5 cover glass, either embedded into a petri dish or
303  divided by plastic-walled growth chambers to optimize microscope optics. Cells were incubated for
304 30 min with a LysoTracker™ Red DND-99 working solution. The staining solution was then

305  aspirated from the plate, rinsed, and subsequently fixed in 4% PFA. Confocal image stacks were
306  captured with a Zeiss LSM-5, Pascal 5 Axiovert 200 microscope, using LSM 5 version 3.2 image
307  capture and analysis software and a Plan-APOCHROMAT 40x/1.4 Oil DIC objective. Images were
308  deconvoluted with National Institutes of Health (NIH) ImagelJ software and BITPLANE-Imaris
309  software. Imaris software analysis was used to measure lysosome number, volume, and area.

310  Experiments were conducted in triplicate, at minimum, and 10-20 cells per condition were

311  quantified.

312  2.7. Immunofluorescence

313 Immunofluorescence was performed as previously described [41,48]. For, live-cell imaging, live cells
314  were plated and imaged in MatTek 35 mm glass-bottom culture dishes and grown on Matrigel. After
315  growth, the cells were fixed with 4% (w/v) PFA in PBS for 30 min, then permeabilized with 0.25%
316  Triton X-100 in PBS for 10 min at room temperature. Fixed cells were then blocked with 10% bovine
317  serum albumin in PBS and incubated with rabbit anti-lysosomal associated membrane protein

318  (LAMP-1; Cell Signal: D2D11) antibody in 1% BSA in PBST (PBS + 0.1% Tween 20) at a 1:25

319  dilution at 4 °C overnight. After three PBS washes, each 5 minutes long, Alexa Fluor 488-conjugated
320  goat-rabbit mouse IgG (Life Technologies: A-11008) secondary antibodies were added at 1:1000
321  dilution in 1% BSA and incubated at room temperature for 45 minutes in the dark. After another

322 three PBS washes, coverslips were mounted onto glass slides with ProLong Diamond Antifade with
323 4’,6-diamidino-2-phenylindole (DAPI) and allowed to dry overnight. Confocal image stacks were
324 captured with a Zeiss LSM-5, Pascal 5 Axiovert 200 microscope, using LSM 5 version 3.2 image
325  capture and analysis software and a Plan-APOCHROMAT 40x/1.4 Oil DIC objective. Imaris

326  software analysis was used to measure lysosome intensity, length, and sphericity. Experiments were
327  performed in triplicate, at minimum, and 10-20 cells per condition were quantified.

328  2.8. Thapsigargin Treatment

329  Fibroblasts, human myotubes, and mouse myotubes were treated with thapsigargin (2 pg mL™;
330  Sigma) for 10 h, followed by crosslinking with Trump’s fixative [49] with 4% PFA and 1%
331  glutaraldehyde for 10 min as previously described [11,50].

332 2.9. TEM Processing of Myoblasts, Fibroblasts, and Myotubes

333 The cell types followed a near identical procedure. Myoblasts and fibroblasts were isolated according
334 to the above methods and placed in six-well poly-D-lysine—coated plates for TEM processing.


https://doi.org/10.1101/2021.09.26.461841
http://creativecommons.org/licenses/by-nc-nd/4.0/

bioRxiv preprint doi: https://doi.org/10.1101/2021.09.26.461841; this version posted August 8, 2022. The copyright holder for this preprint
(which was not certified by peer review) is the author/funder, who has granted bioRxiv a license to display the preprint in perpetuity. It is made

available under aCC-EyNEeYR 461 ¢"PEIVISHASYEID & 3D of Cell. Degradation

335  Myotubes were cultured on Matrigel coated plates. For 1h, cells were incubated at 37 °C with 2.5%
336  glutaraldehyde in 0.1 M sodium cacodylate buffer. This resulted in cell fixation. From there, after
337  rinsing twice with 0.1 M sodium cacodylate buffer, secondary fixation at room temperature for 30
338  minutes to one hour occurred using 1% osmium tetroxide and 1.5% potassium ferrocyanide in 0.1 M
339  sodium cacodylate buffer.

340  After secondary fixation, a five-minute washing with 0.1 M sodium cacodylate buffer (7.3 pH)

341  occurred. From there, two washings of five minutes with diH>O ensured the plates were cleaned.
342 While keeping all solutions and plates at room temperature, the plates had 2.5% uranyl acetate,

343  diluted with H>O, added and were incubated overnight at 4° C. Following this, dehydration was

344  performed though an ethanol gradient series. After dehyrdation, the ethanol was replaced with

345  Eponate 12™ mixed with 100% ethanol in a 1:1 solution. The cells were allowed to incubate, again
346  at room temperature, for 30 minutes. This was repeated three times, for an hour each time using
347  100% Eponate 12™. The plates were finally placed in new media and placed in an oven overnight at
348 70 °C.

349  The plates were cracked upon hardening, and the cells were separated by submerging the plate in
350  liquid nitrogen. An 80nm thickness jeweler’s soul was used to cut the block to fit in a Leica UC6
351  ultramicrotome sample holder. From there, the section was placed on formvar-coated copper grids.
352 These grids were counterstained in 2% uranyl acetate for 2 minutes. Then these grids were

353  counterstained by Reynold’s lead citrate for 2 minutes. Images were acquired by TEM on either a
354  JEOL JEM-1230, operating at 120 kV, or a JEOL 1400, operating at 80kV.

355  2.10. Systematic ImageJ Parameters and Measurement

356  Using documented parameters and quantification methods [11], a unique individual imaged the entire
357  cell at low magnification. Obtained images were uploaded to ImagelJ in an acceptable format, such as
358  TIFF. The cell was then divided into quadrants using the ImageJ quadrant picking plugin

359  (https://imagej.nih.gov/ij/plugins/quadrant-picking/index.html, accessed August 21, 2021) to ensure
360 random and unbiased quadrant selection for quantification. After sectioning the image into four

361  quadrants, two quadrants were randomly selected for complete analysis. Three independent, blinded
362  individuals quantified these quadrants as described below. Their collective findings were averaged to
363  decrease individual subjective bias. To ensure accurate and reproducible values, measurements were
364  repeated on a minimum of 10 cells each. In the future, if significant variability is observed among the
365 individuals performing the analysis, increasing the sample number (n) by expanding the number of
366  cells quantified was found to decrease variability.

367  All analysis methods were developed using NIH ImagelJ software. Necessary measures should be set
368  on Imagel] prior to analysis (Analyze > Set Measurements: Area, Mean gray value, Min & Max gray
369  wvalue, Shape descriptors, integrated density, Perimeter, Fit ellipse, Feret’s Diameter). Lysosomes,
370  autolysosomes, LDs, and autophagosomes, were measured, including area, circularity, and length
371  using the Multi-Measure region of interest (ROI) tool in ImagelJ based on established measurements
372 [11,51]. Using the freehand tool in NIH ImageJ 1.49, we manually traced the cellular degradation
373  machinery membrane to determine area or volume. A 19 x 23 cm rectangular grid was overlaid on
374  each image to quantify cellular degradation structures and the numbers were presented per 10 pm? of
375  cytoplasm.

376  2.11. Statistical Analysis
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377  Results are presented as the mean + standard error of the mean. Data were analyzed using unpaired
378  Student’s T-tests. If more than two groups were compared, one-way analysis of variance (ANOVA)
379  was performed, and significance was assessed using Fisher’s protected least significance difference
380  test. For T-tests and ANOVA, the GraphPad and Statplus software packages were used (SAS

381 Institute, Cary, NC). For all statistical analyses, significant differences were accepted when p < 0.05.

382 2.12 3D reconstruction of cellular degradation components using Amira

383  Following isolation of myotubes in a flex fixative, serial block face-scanning electron micrscopy was
384  performed according to established protocols [16]. Once isolated, Amira 3D reconstruction

385  (ThermoFisher Scientific; Waltham, Massachusetts) software was utilized to perform 3D

386  reconstruction of machinery according to the protocol found in Section 3. All videos were created in
387  the Amira software program according to Garza-Lopez et al. 2022 [16].

388 3 Protocol
389 TEM PROTOCOL.:
390  3.1. Downloading and Preparing ImageJ Software for Analysis

391  3.1.1. Download ImageJ software from the official NIH website
392  (https://imagej.nih.gov/ij/download.html).

393  3.1.2. Install and open the Imagel] software.

394  3.1.3. Select Analyze » Tools ®» ROI Manager to open the ROI Manager, which is used to record and
395  track measurements.

396  3.1.4. Click on Analyze » Set Measurements to input the measurements for ImagelJ to perform, such
397  as area, circularity, and perimeter.

398  3.1.4.1. For the current protocol, area and count were the focus; however, all available measurements
399  may be used, depending on the study aims.

400  3.1.5. Import image to be analyzed directly into ImageJ. A TIFF or DM3 file is recommended to
401  provide high-quality.

402  3.1.5.1. Alternatively, click File ® Open to open the selected image.

403  3.1.6. Considerations

404  3.1.6.1. For accuracy and reproducibility, ensure that each image contains a scale bar, bar length, and
405  image magnification. The scale bar and bar length are important for setting the appropriate units in
406  the Imagel settings.

407  3.1.6.2 Quantification of samples should be performed by three individuals in a randomized and
408  blinded manner to ensure an unbiased approach.

409  3.1.6.3. To save time, images may be divided into quadrants, and same quadrants should be analyzed
410  across all images.
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411  3.2. Analyzing Lysosomes, Autophagosomes, and Autolysosomes (Supplementary Figure 2A—C)
412 3.2.1. Click on Freehand Selections to access the Freehand tool.

413 3.2.2. Trace the outline of the entire cell.

414  3.2.3. Click Add on the ROI Manager. This ROI will be used to normalize later measurements.

415  3.2.4. To obtain length and width, use the Straight-Line tool to draw a line down the major and minor
416  axes of each organelle (Supplementary Figure 2A—C, Step 1).

417  3.2.5. Trace the membrane of each lysosome, autophagosome, or autolysosome. Add the shape to the
418  ROI Manager (Supplementary Figure 2A—C, Step 2).

419  3.2.6. Click Measure in the ROI Manager to obtain the area measurements.

420  3.2.7. Add the measurements to the ROI Manager and use the Measure function to obtain numerical
421  values for each measurement.

422  3.2.8. Considerations

423 3.2.8.1. Ensure that autophagosomes, lysosomes, and autolysosomes are measured separately because
424 the ROI Manager will group all functions for statistical analysis.

425  3.2.8.2. The number of autophagosomes, lysosomes, or autolysosomes counted in the cell should be
426  normalized against the total cell area.

427  3.3. Analyzing Lipid Droplets

428  3.3.1. Repeat Steps 2.1-2.5 for LDs to obtain basic measurements needed for analysis
429  (Supplementary Figure 2D).

430  3.3.2. For each cell, calculate total area of all LDs. The amount of lipid coverage is the total area of
431  all LDs divided by total cell area.

432 3.3.2.1. This process can be used to determine the percent coverage of other subcellular structures,
433 including mitochondria and recycling machinery.

434  3.3.3. Contact sites between organelles can be measured by first using the Freehand tool to trace the
435  outer membranes of both subcellular structures being analyzed, as described in Step 2.4
436  (Supplementary Figure 2D, Step 1).

437  3.3.4. To determine the contact site length, click on the Straight, Segmented, or Freehand Lines tool
438  on the toolbar, and select Freehand Line. Draw a line spanning the length of the contact site, add the
439  measurement to the ROI Manager, and use the Measure function to determine the contact length
440  (Supplementary Figure 2D, Step 2).

441  3.3.5. Contact distance may be similarly measured using the Freehand Line tool to draw a line
442  between two objects being measured.
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443  3.3.6. Calculate percent coverage by dividing the cumulative contact lengths by the percent coverage
444 of one of the two subcellular features in question, as determined in Step 3.2. Multiply the value by
445 100 to obtain a percentage.

446 3D RECONSTRUCTION PROTOCOL (UTILIZING WACOM TABLET):

447  3.A. Download Amira software from https://www.thermofisher.com/us/en/home/industrial/electron-
448  microscopy/electron-microscopy-instruments-workflow-solutions/3d-visualization-analysis-

449  software/amira-life-sciences-biomedical.html (accessed on 4 August 2022) and open.

450

451  3.B. Transfer all orthoslices to be analyzed from Project View > Open Data. Ensure all are

452  transferred by selecting Read Complete Volume into Memory.

453  3.C. Navigate between the Project subsection, to select images to analyze and the

454  the Segmentation subsection, to alter segmentation tools. We recommend the Brush tool with a size
455  of 2.

456

457  3.D. Calibrate the Wacom Pen and open Amira on the Wacom tablet in accordance with prior

458  protocols [16].

459

460  3.E. Using arrow keys, scroll through orthoslices until desired recycling machinery is found. It is
461  recommended to verify its identity by looking at additional orthoslices. For each organelle, outline
462  with a material and press F to segment area. Alter material for each organelle to pseudo color

463  organelles.

464  3.F. Repeat this process for each ortho slice that organelle appears on, making sure that all
465  independent organelles consistently use the same material color. Later on, aspects of these materials,
466  such as color and visibility, can be altered on the Materials menu.

467  3.G. Once all are segmented, on the Project Menu, click on Selection Labels > Generate Surface
468  and select Apply.

469  3.H. In the workplace area of Amira, rename the newly generated box with the “. surf” suffix and
470  click Surface View. Toggle orthoslice and 3D reconstruction materials on and off to switch between
471  isolated and overlay view.

472  3.1. Make scale bars by right-clicking in the gray area under the Project subsection and selecting the
473  option Scalebars. Adjust scale bars as necessary, with a readable width and font, as well as only
474  leaving x-axis, unless y-axis scale is also necessary.

475  3.J. Previously [16], mitochondrial quantifications performed has included volume, 3D area, and

476  length. Furthermore, mitochondrial complexity index is measured by SA3/16pi*V? while

477  mitochondrial branching index measures transverse branching divided by longitudinal branching

478  [52]. While created for mitochondria, these same quantifications can be used as parameters for

479  recycling machinery. Additionally, recycling machinery has other quantifications that may be applied
480  including mitochondrial-lysosome or lipid droplet-mitochondrial interactions distances and surface
481  area interactions.

482
483 4 Result
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484  This protocol describes a method to obtain reproducible measurements and identify structures
485  involved in autophagy. Below, we show the results obtained using this TEM image analysis
486  approach.

487  4.1. Identification of organelle compartments by immunogold labeling

488  With the pitfalls associated with correctly identifying organelles by TEM morphology alone, other
489  methods may be required to confirm organelle identity. One of the most effective alternatives is
490  immunogold labeling used in electron microscopy to analyze organelle marker proteins. As a

491  positive-control, it is useful to perform immunogold labeling on a easily identifiable organelle. For
492  example, mitochondrial GTPase proteins, mitofusin 1 and 2 (MFN1 and MFN2), function in

493  mitochondrial fusion reactions [35,36,53—56] and MFN1 is used to identify mitochondria in tissues
494  as MFNI1-positive puncta (Figure 2P-Q).

495  Immunogold labeling can also be used to identify organelles associated with autophagy. Many novel
496  yeast genes that are essential for autophagy (autophagy-related, or ATG genes) have been

497  characterized, and most of their mammalian homologs have been identified [57]. Microtubule-

498  associated protein 1 light chain 3 (LC3), the mammalian homolog of Atg8 [58], is a reliable marker
499  for mammalian autophagosomes, which can be identified by the formation of LC3 labeling along the
500 limited membrane (Figure 2R—S). LC3 expression in autophagosomes (Figure 1, blue arrows) and
501  phagophores (not shown) may vary due to LC3 degradation by lysosomal hydrolases, making it a
502  challenge to identify late-stage autophagic materials [59]. Moreso, since autophagosomes are three-
503  dimensional organelles and are being imaged in two-dimensions. However, identifying LC3-positive
504  puncta is still valuable to identify autophagosomes. Immunogold labeling has also been performed
505  with caveolin-1 (CAV-1), a marker protein for specialized membrane domains known as caveolae,
506  which ultimately accumulate in caveosomes that mature into MVBs upon endocytosis [60].

507  Therefore, CAV-1 immunogold labeling can be used to identify vesicles (Figure 2T—U) and the

508  presence of CAV-1 puncta in an ROI excludes those vesicles from classification as autophagosomes,
509 indicating instead a vesicle such as, multivesicular or multi-inclusion body. After testing

510  immunogold labeling, we examined changes in cellular degradation machinery under other

511  conditions.

512 4.2. Thapsigargin treatment alters lysosome, autolysosome, and autophagosome morphology

513  Thapsigargin is a sarcoplasmic-ER Ca?’-ATPase (SERCA) inhibitor, that decreases the length of
514  mitochondria—ER contacts in treated cells, while also inducing ER stress [11,61]. We investigated
515  morphological changes in lysosomes, autolysosomes, and autophagosomes in response to

516  thapsigargin (Figure 3) using our TEM image analysis protocol. We found that mean lysosomal area
517  and the number of lysosomes per square micron significantly increased in response to thapsigargin
518  treatment in primary mouse skeletal myotubes (Figure 3E-F). The mean area of autolysosomes and
519  the number of autolysosomes per square micron had an even greater increase than seen in lysosomes
520  (Figure 3G—H). The mean autophagosomal area and number of autophagosomes per square micron
521  also significantly increased in thapsigargin-treated cells (Figure 31-J). Similar results were seen in
522 mouse fibroblasts (Figure 3K—T) and human myotubes (Figure 3U-AD). Human myotubes displayed
523  the largest increases in autophagy recycling machinery of all assessed components. These

524  quantifications are shown with representative images for each cell type (Figure 3A-D, K-N, and U—
525  X). The ability of thapsigargin to inhibit ER function and promote cell stress support a model in

526  which cell-stress-induced organellar damage increases lysosome and autophagosome degradation of
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527  damaged organelles. Thus, morphological changes detected and quantified using our TEM method
528  are consistent with the expected effects of thapsigargin treatment.

529  4.3. DRP-1 ablation results in increased degradation machinery

530  Dynamin-related protein (DRP-1) is a crucial regulator of mitochondrial fission [43,62]. Previous
531  studies found that impaired mitochondrial fission can have downstream effects on organellar

532 morphology and function throughout the cell [63]. In the absence of DRP1, mitochondria undergo
533 fission less frequently, resulting in longer mitochondria that can trigger downstream effects,

534  including apoptosis [62]. To test our method, we generated a skeletal muscle-specific Drpl knockout
535  mouse and noted changes in the degradation machinery. Specifically, our study focused on

536  lysosomes, autophagosomes, and LDs, which are all closely linked to the autophagy process. Drpl
537  ablation in a skeletal myotube-specific knockout model (DRP-1smKO), resulted in significantly more
538  lysosomes than in wild-type controls (Figure 4A—F, red arrows). We also found increased lysosome
539  numbers per square micron and lysosomal area per square micron, although the change in lysosomal
540  area was not as great as the change in lysosome number (Figure 4G—H). Similarly, DRP-1smKO also
541  showed a significant and large increase in autophagosome number over wild-type controls (Figure
542 4I-L, red arrows). We also observed increased autophagosome number per square micron and

543  autophagosome area per square micron, although the change in area was less than the change in

544  number (Figure 4M-N). Based on changes in percentage and degree of significance, the

545  autophagosome increase was greater than the lysosome increase, suggesting that reduced

546  mitochondrial fission may cause larger shifts in cargo vessel formation than in lysosome formation,
547  although both organelle types increased significantly. Autophagosome-lysosome fusion events may
548  also contribute to this disparity, as intermediate fusion phase structures more closely resemble

549  autophagosomes than lysosomes.

550  To validate these results, we used the fluorescent dye, LysoTracker, to image lysosomes in DRP-
551  1smKO myotubes because its ability to label and track acidic organelles in live cells allows it to

552  effectively identify highly acidic lysosomes. Similar to TEM data, the LysoTracker assay showed
553  significantly more lysosomes in DRP-1smKO myotubes than in wild-type controls (Figure 40-P).
554  Increased lysosome number, calculated lysosome volume, and lysosomal area were also observed in
555  DRP-1 knockout mice (Figure 4Q-S). These key quantitations are similar to those determined by
556  TEM analysis; however, LysoTracker provided better certainty of lysosome identity and allowed use
557  of traditional statistical analyses to determine lysosome area and numbers. Lysosomes can also be
558 identified by LAMP1 immunostaining (Figure 4T-U) [64], which correlates with the number and
559  size of active lysosomes (Figure 4V). While relative intensity can estimate LAMP1 expression,

560  lysosome area measurements are not reliable by LAMP staining. Other metrics, including length and
561  sphericity, can be determined using these fluorescent dyes, suggesting that lysosomal dysfunction
562  occurs as length increases and sphericity decreases (Figure 4 W—X).

563  To further validate these results and see if the 3D structures of recycling machinery showed

564  significant differences upon loss of DRP-1, we also provide representative 3D reconstruction of both
565  lysosomes (Figure 4Y-AB’’; SV1-4) and autophagosomes (Figure 4AC-AF’’; SV 5-8). The top

566  image shows a representative orthoslice of the region of interest (Figure 4Y-AF). Once segmentation
567  was performed, organelle 3D reconstructions were overlaid on the orthoslice (Figure 4Y’-AF’). To
568 allow for better visualization, we also show isolated 3D reconstruction on the X- by Z- plane to allow
569  for their depth to better be visualized (Figure 4Y’’-AF’’). However, static images of 3D

570  reconstruction may not capture the scope of 3D reconstruction; therefore, we also provide associated
571  videos showing organelles for all representative images (SV 1-8). Our study shows that lysosomes
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572  appear larger in DRP-1 smKO (Figure 4AB’’). Additionally, upon loss of DRP-1 lysosomes appear
573  to be closer together in 3-dimensional spatial orientation (Figure 4AA’’-AB’’). Autophagosomes

574  appear to have a less significant alteration, but they do appear to be more elongated in the z-axis upon
575  DRP-1 smKO (Figure 4AC’’-AF”’), a detail that would otherwise not be observed in TEM.

576  4.4. DRP-1 ablation results in increased lipid droplets

577  We also measured LDs in skeletal muscle from DRP-1smKO mice, which had significantly more
578  LDs than WT controls (Figure SA-B, red arrows). We observed a large increase in lipid area and
579  number of LDs per square micron (Figure SC-D). Based on percent change, the LD increase was
580  larger than the observed increases in both lysosomes and autophagosomes following DRP-1 ablation
581  (Figures 4 and 5). To see if spatial relationships of LDs changed upon DRP-1 loss, we also looked at
582  SBF-SEM 3D reconstruction of LDs. For both WT and DRP-1smKO mice we show a representative
583  x- by y-plane orthoslice (Figure SE-H), 3D reconstruction overlaid on orthoslice (Figure SE’-H”),
584  isolated 3D reconstruction showed on a slightly different plane, the X- by Z-plane, to allow for depth
585  to better be visualized (Figure SE’’-H’”), and video of isolated 3D reconstruction (SV 9-12). We

586  observed that after DRP-1 loss, LDs were much more clumped, both on the x- and y- axis, but also
587  on the z-axis, and lipid droplets appeared to be larger sizes (Figure 5G’’-H’).

588  4.5. Knockdown of Marf resulted in more abundant lysosomes

589  In addition to DRP-1, we sought the quantify lysosomal changes in response to knockdown of other
590  key mitochondrial proteins. Mfn2 is an important regulator of mitochondrial fusion [65,66] and Mfn2
591  deficiency has been associated with disrupted ER morphology and mitochondria—ER contacts,

592  resulting in dysfunctional calcium signaling [65,66]. Loss of Mfn2 was also recently shown to

593  influence autophagic pathways [65—68] by stalling autophagy at the lysosome and autophagosome
594  stages, causing a buildup of both autophagosomes and lysosomes by inhibiting their fusion [68]. The
595  Drosophila homolog of Mfn2 is Marf, and knockout of genes upstream of Marf had downstream

596  effects on autophagy [67]. Given this emerging link between autophagy and Marf/Mfn2, we

597  examined the effects of Marf knockdown in Drosophila tissue, which produced a significant and

598 large increase in lysosome number compared with WT controls (Figure 6A—B, D). We also observed
599  anincrease in average lysosomal area (Figure 6C). These findings indicate a potential upregulation of
600  autophagy, which may represent an autophagic response to ER and mitochondrial stress caused by
601  loss of Marf [65—-68]. Further research into changes in other cellular degradation machinery

602  following loss of Mfn2/Marf could better elucidate the effects of Mfn2/Marf on autophagy.

603 5 Discussion

604  The method we have described involves measuring organelles in each image or image quadrant by
605  defining the area of interest using digital tools, rather than the often-used method of point counting.
606  Point counting can be used to determine the cellular area by laying a grid over the cellular area and
607  determining the distance between gridlines and the number of grid intersections, or points, within the
608  cell. Cellular area may then be estimated using the equation P x d2, where p is the number of points
609 and d is the grid distance [40]. Smaller grids can be used to repeat the process for estimating

610  organelle area, and these two values can then be used to determine the percent coverage of

611  organelles. Past studies have used point counting to successfully streamline the process of calculating
612  organelle coverage; however, this method only provides estimations [40]. Even with smaller grid
613  distances, which can increase the calculation accuracy, this approach still requires estimation. The
614  method we described uses ImagelJ to more precisely calculate the structure areas. Although using
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615  Imagel is more time-consuming, the results are highly reproducible, generating high-quality data that
616  may be further analyzed using ImageJ. Both analyses require human evaluation and proper

617  identification of the recycling machinery. Both point counting and ImageJ-based measurements are
618  viable ways to measure the frequency of recycling or other types of organelles; however, we believe
619  the accuracy of measurements with ImageJ analysis is worth the increased time commitment [23,24].

620  An important consideration in the use of TEM is the magnification and scope of cellular degradation
621  machinery components to be considered in these analyses. Significant size heterogeneity is seen

622  among components of the degradation machinery, even within the same classification group, which
623  can vary according to the amount of cargo they carry (Figure 1). For TEM imaging, various organelle
624  types and sizes may require different magnifications (Supplemental Figure 1). Additionally, the

625  purpose of the analysis must be considered when deciding which types of recycling machinery to

626  evaluate, and appropriate statistical analyses should be used (Supplemental Figure 1). For example,
627  the total number of LDs may not be as important as their total cell coverage due to varying LD sizes
628  and proper magnification should be determined based on the necessary measurements to be

629  performed (Supplemental Figure 1). A limitation of our method is that for key measurements, such as
630 area, the total organelle must be visualized to obtain accurate results. Point counting can be used to
631 evaluate images in which the entire organelle is not visible because it relies on estimation [40]. When
632  using Imagel, the entire organelle is outlined, and magnification that is too high may limit the

633  amount of data that can be collected. However, images of a single cell at varying magnifications may
634  be used by normalizing to a consistent scale across all images.

635  Although this protocol focuses primarily on evaluation of the degradation machinery, these

636  organelles must not be viewed in a vacuum. Autophagy can target any cell, and many factors can
637  alter autophagy processes in different cells, as seen in cancer, metabolic diseases, or

638  neurodegenerative diseases [1,4,12]. Many organelles are closely associated with the overall

639  autophagy process. Recent research found that omegasomes and autophagosomes primarily form at
640  mitochondria—ER contact sites [39], which may be because the ER phospholipid,

641  phosphatidylinositol 3-phosphate, is needed to activate and form autophagosomes [1-3].

642  Mitochondrial-derived vesicles can also influence autophagic pathways by transporting proteins and
643  lipids associated with the mitochondria to MVBs [69]. This previously unknown pathway indicates
644  that mitochondria that are not sufficiently damaged to trigger mitophagy can still produce endocytic
645  bundles that are transported to the MVB for recycling via the autophagic pathway. Because cellular
646  degradation machinery can have important effects on organelles, and the inverse is also true, a

647  holistic view is needed to understand the nuances that influence autophagy.

648  The protocol described here is optimized for statistical analyses; however, it is important to ensure
649  that correct subcellular features of lysosomes, autophagosomes, and LDs are identified and measured.
650  Although organelles can be accurately identified by TEM alone, methods, such as

651  immunofluorescent staining, are recommended in tandem with TEM to achieve clear results,

652  particularly when analyzing lysosomes, autophagosomes, and autolysosomes, which are easily

653  misidentified (Figures 1-2 and 4). Because examining organellar morphology using TEM alone may
654  lead to inaccurate conclusions, we suggest coupling TEM with methods such as immuno-TEM with
655  gold labeling, LysoTracker with correlative light and electron microscopy, and

656  immunohistochemistry or immunofluorescence (Figure 2 and 4) to verify the identity of each

657  structure [5,57,70].

658  Given the acidity and multitude of proteins associated with lysosomes, there are various ways to
659  identify lysosomes using immunogold labeling, LysoTracker to identify acidic organelles,
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660  immunofluorescent dyes to label lysosome-associated proteins such as LAMP1(Figure 4T-U) [64],
661  and indirect immunofluorescence using secondary antibodies bound to a lysosome-associated

662  primary antibody [71,72]. When combining confocal fluorescence imaging and TEM, fluorescence
663  can be used to identify specific proteins and confirm the identities of autophagic organelles (Figure
664  40-X), and TEM can be used to measure finer details, including area, average number, and percent
665  coverage (Figure 4A—N). SBF-SEM can from there allow for 3D visualizations and to see details
666  that may not be seen in the 2D plane (Figure 4Y*’-AF’’; Figure SE’-H*’; SV 1-12). 3D

667  reconstruction can importantly allow for visualization of how organelles exist in relation to each
668  other in a 3D spatial orientation as well as if there is alterations in specifically transverse or

669 longitudinal organelle volumes [16].

670  Current options to identify and classify autophagosomes are limited. Immunogold labeling can be
671  used to detect LC3, which is currently a commonly used autophagosomal marker that proved

672  effective for our research [57,70,73]. LC3 puncta are not always detectable in autophagosomes;
673  however, immunogold labeling can be used to identify organelles to be excluded from

674  autophagosomes analysis. For example, CAV-1 staining (Figure 2T—U), which is associated with
675  caveolae typically found in MVBs, can identify MVBs that might be mistaken for autophagosomes
676  (Figure 2) [60]. Similarly, perilipin 2, a commonly expressed protein associated principally with
677  LDs, can be used to identify LDs [74]. Future studies that explore new improved immunogold or
678  immunofluorescence labeling options for autophagosomes will be important. Due to the potential
679  ambiguity associated with identifying the cellular degradation machinery, we recommend using at
680 least one additional complementary technique to verify lysosome and autophagosome identity when
681  measuring TEM images. Future studies may also perform quantifications of 3D reconstruction to
682  determine more detailed changes beyond those only shown by TEM.

683  Using the method outlined here, we have quantified the changes associated with macro autophagy
684  upon treatment with thapsigargin, loss of DRP-1, or knockdown of MARF. Thapsigargin treatment,
685  this is known to cause ER stress and past research has shown that such ER stress promotes

686 lipotoxicity and the formation of lipid droplets [75,76]. Given these previous findings, we believed
687 that autophagy may increase upon thapsigargin treatment in addition to lipid droplets, as previously
688  established for lipid droplets. Specifically, this hypothesized this would come across given that past
689 literature has found that macro autophagy can serve as a protective mechanism for ER stress [77,78].
690  Our results support the autophagic response to ER stress, as autolysosome, autophagosome, and

691  lysosomes all increased in quantity in three different models (Figure 3). Critically, we also examined
692  size of these organelles, as past literature has also suggested that the size of these organelles relates to
693 their efficiency and function [37,79,80]. In combination, our results show in all three models a large
694  increase in autophagy machinery. ER stress is typically caused by dysregulation of protein folding,
695  causing dysregulation of ER homeostasis [77]. In response, the unfolded protein response is

696 activated, which can have a downstream effect of increasing autophagy to remove defective organelle
697  and macromolecules [81]. Similarly, loss of DRP-1 also was demonstrated to cause an increase in
698  autophagy as seen by increases in size and quantity of organelles and increased LAMP1 expression
699  (Figure 4), and autophagy likely increases through a similar mechanism. Increased LDs have

700  previously been described as a downstream effect of autophagy, consistent with the conclusion that
701  autophagy occurs more frequently following DRP-1 ablation [32]. Increased autophagy may be due
702 to dysfunctional regulation of mitochondrial length, which is seen in response to loss of DRP-1

703  regulated fission [32,62]. These results suggest that DRP-1 ablation and the resulting lack of

704  mitochondrial fission increase autophagy in cells, demonstrated by upregulation of the cellular

705  degradation machinery. In past studies, mice lacking DRP-1 have had increased accumulation of
706  damaged mitochondria [63], which may induce increased mitophagy and relevant recycling
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707  machinery. While DRP-1 is typically associated for regulation of mitochondrial fission [43], past

708 literature has also implicated the loss of DRP-1 with ER stress [82]. Specifically, this may come as a
709  result of loss of calcium homeostasis between the dysfunctional mitochondria and ER. Therefore, this
710  is a possible reason for why loss of DRP-1 mimics the changes seen upon thapsigargin treatment.

711  Similarly, past research has also shown that MFN-2 increases ER stress [83]. found that loss of

712 MAREF, the fly homolog of MFN2, increased autophagic organelles, further showing a potential

713 increase in autophagy due to ER stress due to the unfolded protein response. Future research may
714 consider studying specificically ER-phagy with this method to better understand how ER-stress

715  activates autophagy, and verify that DRP-1 and MAREF loss increase autophagy as a downstream

716  effect of ER stress.

717  Although limitations of this TEM analysis and SBF-SEM visualization method exist, when combined
718  with other techniques, reliable identification and quantitation of cellular degradation machinery

719  components may be possible. On a broader scale, this method using ImageJ and/or Amira may be
720  applied to other fields with a focus on organelle structure. For example, mitochondria play key roles
721  in many complex diseases, including type II diabetes, cardiomyopathy, and Alzheimer’s disease

722 [35,36,53-56] and autophagy may contribute to these diseases, given its role in mitophagy to clear
723 dysfunctional mitochondria. Use of TEM and ImageJ to study other organelles in conjunction with
724 the precise methodology outlined here to study key autophagic organelles will improve our

725  understanding of the physiology associated with key organelles and their contributions to disease.

726 6 Perspective on Staining

727  Lysosome stages may look different when using different EM staining procedures, depending on the
728  material used for preparation (e.g., osmium tetroxide) and the type and amount of additives used

729  (e.g., uranyl acetate, lead citrate, and ruthenium red). Depending on the stain used, lysosomal

730  membrane contrast may be altered, affecting the appearance of lysosome-related structures. All EM
731  images shown here used a grid-based staining technique in all procedures (Table 2). The general

732 TEM sample preparation protocol used glutaraldehyde and 1% osmium tetroxide as fixatives [84—
733 87]. Post staining on TEM ultrathin sections used 5% uranyl acetate for 6 min to increase membrane
734  contrast and Reynold’s Lead Citrate for 3 min to improve resolution of cellular structures [88—90].
735  Other stains may be used to optimize the experimental purpose, and staining time should be adjusted
736  according to the sample type. Other viable alternatives exist; for example, ruthenium tetroxide is

737  particularly useful when preparing kidney, liver, and prostate tissue [91,92]. Ammoniated ruthenium
738  oxychloride, commonly referred to as ruthenium red, is frequently used as a polycationic dye to stain
739  negatively charged molecules, including polysaccharides, in tissue sections [93-95]. Although

740  ruthenium red is commonly used for fungal staining, when used with osmium tetroxide, a chemical
741  reaction occurs that may increase the contrast of TEM micrographs [93-95]. Regardless of the stain
742  used, the foremost concern should be maintaining consistency in tissue staining. Different staining in
743  the same organism for example, staining separately for lysosomes, should be avoided. Ideally, the
744  same staining solution should be used for all samples, even at different stages, making it possible to
745  compare different times or stages. If staining protocols different from those described here are used,
746  lysosome appearance may vary.
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